
AVEVA™ 

 

 

formerly Wonderware 

InTouch HMI 

InTouch HMI and ArchestrA Integration Guide 

 

 
 



 AVEVA™ InTouch HMI formerly Wonderware InTouch HMI and ArchestrA Integration Guide 

 

 2 
 

© 2020 AVEVA Group plc and its subsidiaries. All rights reserved.  

  

No part of this documentation shall be reproduced, stored in a ret rieval system, or transmitted by any 

means, electronic, mechanical, photocopying, recording, or otherwise, without the prior written 
permission of AVEVA. No liability is assumed with respect to the use of the information contained herein.  

Although precaution has been taken in the preparation of this documentation, AVEVA assumes no 

responsibility for errors or omissions. The information in this documentation is subject to change without 
notice and does not represent a commitment on the part of AVEVA. The software describe d in this 
documentation is furnished under a license agreement. This software may be used or copied only in 

accordance with the terms of such license agreement.  

ArchestrA, Aquis, Avantis, Citect, DYNSIM, eDNA, EYESIM, InBatch, InduSoft, InStep, IntelaTrac,  
InTouch, OASyS, PIPEPHASE, PRiSM, PRO/II, PROVISION, ROMeo, SIM4ME, SimCentral, SimSci, 

Skelta, SmartGlance, Spiral Software, Termis, WindowMaker, WindowViewer, and Wonderware are 
trademarks of AVEVA and/or its subsidiaries. An extensive listing of AVEVA trademarks can be found at: 
https://sw.aveva.com/legal. All other brands may be trademarks of their respective owners.  

Publication date: Wednesday, November 4, 2020 
 

Contact Information 

AVEVA Group plc  
High Cross 
Madingley Road 

Cambridge 
CB3 0HB. UK 

https://sw.aveva.com/ 

For information on how to contact sales and customer training, see https://sw.aveva.com/contact. 

For information on how to contact technical support, see https://sw.aveva.com/support.  
 



 AVEVA™ InTouch HMI formerly Wonderware InTouch HMI and ArchestrA Integration Guide 

 

 3 
 

Chapter 1  About InTouch HMI and ArchestrA Integration............................................... 7 

About InTouch HMI and ArchestrA Integration  Overview............................................................ 7 

Standalone InTouch Applications  ............................................................................................... 7 

Managed InTouch Applications  .................................................................................................. 8 

Published InTouch Applications  ................................................................................................. 9 

Application Server Architecture ................................................................................................ 10 

Communication within the Galaxy....................................................................................... 11 

Industrial Graphic Editor .......................................................................................................... 11 

Comparing Standalone, Managed, and Published InTouch Applications  ..................................... 12 

Managing InTouch Applications Using the ArchestrA IDE .......................................................... 13 

InTouchViewApp Object .................................................................................................... 14 
Associating an InTouchViewApp Template with an InTouch Application  .......................... 15 
Editing a Managed InTouch Application ........................................................................ 15 
Testing a Managed InTouch Application........................................................................ 15 
Deploying the InTouchViewApp Object ......................................................................... 16 
Exporting and Importing an InTouchViewApp Object...................................................... 16 
Exporting and Importing Tag Data Associated with a Managed InTouch Application  ........ 16 
Publishing Managed InTouch Applications .................................................................... 16 
Exporting and Importing InTouch Windows between InTouch Applications  ...................... 17 
Attributes of the InTouchViewApp Object ...................................................................... 17 
Differences Between the InTouchViewApp Object and Other AutomationObjects ............ 18 

ViewEngine Object  ............................................................................................................ 18 

Industrial Graphics .................................................................................................................. 19 

Creating Industrial Graphics ............................................................................................... 19 
Embedding Industrial Graphics into InTouch Windows ......................................................... 20 
Creating New ArchestrA Object Instances Automatically  ...................................................... 20 
Exporting and Importing Industrial Graphics as XML Files .................................................... 20 
Implementing the GraphicAccess API ................................................................................. 21 
Creating Symbol Wizards with the Symbol Wizard Editor  ..................................................... 21 

Creating Symbol Wizards ............................................................................................. 22 
Symbol Wizard Designer Workflow ............................................................................... 22 
Symbol Wizard Consumer Workflow ............................................................................. 22 

Symbol Change Propagation ............................................................................................. 23 
Symbol Dynamic Size Propagation ..................................................................................... 23 

Chapter 2  Managing InTouch Applications with the IDE ............................................... 25 

Managing InTouch Applications with the IDE  About Managing InTouch Applications with the IDE
 ............................................................................................................................................. 25 

Creating a Managed InTouch Application ................................................................................. 26 

Creating a Managed Application from an Application Template  .................................................. 29 

Starting WindowMaker from the ArchestrA IDE  ......................................................................... 32 

Contents 



Contents AVEVA™ InTouch HMI formerly Wonderware InTouch HMI and ArchestrA Integration Guide 

 

 4  

Submitting Changes for an InTouch Application  ........................................................................ 33 

Importing an InTouch Application ............................................................................................. 34 

Importing and Exporting an InTouchViewApp Object ................................................................. 37 

Publishing a Managed InTouch Application............................................................................... 37 

Deleting a Managed InTouch Application .................................................................................. 38 

Exporting and Importing Tag Data ............................................................................................ 39 

Retaining Tag Value and Parameters ....................................................................................... 39 

Language Switching for a Managed InTouch Application ........................................................... 40 

Adding Files for a Managed InTouch Application  ....................................................................... 40 

Associating All Galaxy Graphics in an InTouchViewApp  ............................................................ 41 

Chapter 3  Using Industrial Graphics in WindowMaker .................................................. 43 

Using Industrial Graphics in WindowMaker  About Using Industrial Graphics in WindowMaker .... 43 

Embedding Industrial Graphics into an InTouch Window............................................................ 44 

Embedding Industrial Graphics from Automation Templates ................................................. 44 
Embedding Industrial Graphics from Instances .................................................................... 45 
Embedding Industrial Graphics from the Graphic Toolbox  .................................................... 46 
Embedding Industrial Graphics with Element Styles Applied  ................................................ 47 
Embedding Symbol Wizards  .............................................................................................. 47 

Resizing Embedded Industrial Graphics ................................................................................... 47 

Configuring Industrial Graphics in WindowMaker....................................................................... 48 

Configuring WindowMaker Animation Links of an Industrial Graphic  ..................................... 48 
Connecting Industrial Graphics to InTouch Tags  ................................................................. 50 
Example of Connecting Industrial Graphics to InTouch Tags  ................................................ 51 
Selecting Alternate Instances from the Same Parent  ........................................................... 55 
Selecting Alternate Symbols of the Same Instance  .............................................................. 55 
Substituting Strings in Industrial Graphics ........................................................................... 56 
Substituting References in Industrial Graphics  .................................................................... 56 
Enabling or Disabling Dynamic Size Change Propagation of Embedded Industrial Graphics  .. 56 
Associating Scripts with ArchestrA Symbols ........................................................................ 56 

Using Methods in ArchestrA Symbol Scripts .................................................................. 57 

Editing Industrial Graphics in the Industrial Graphic Editor  ......................................................... 58 

Editing an Embedded Industrial Graphic  ............................................................................. 58 
Accepting Symbol Changes in WindowMaker...................................................................... 59 
Accepting Symbol Changes in WindowViewer..................................................................... 59 

Testing Industrial Graphics in WindowViewer............................................................................ 60 

Estimating Graphic Performance.............................................................................................. 62 

Creating New Automation Instances ......................................................................................... 62 

Chapter 4  Using Managed InTouch Applications at Run Time .................................... 63 

Using Managed InTouch Applications at Run Time  About Using Managed InTouch Applications at 
Run Time............................................................................................................................... 63 

Deploying a Managed InTouch Application ............................................................................... 64 

Deploying a InTouchViewApp Object for the First Time........................................................ 64 
Deploying Changes to a Managed InTouch Application  ....................................................... 64 

Starting a Managed InTouch Application................................................................................... 64 



Contents AVEVA™ InTouch HMI formerly Wonderware InTouch HMI and ArchestrA Integration Guide 

 

 5  

Controlling the WindowViewer Restart Wait Period When Deploying Managed Applications ... 65 

Accepting New Application Versions at the Operator Node  ........................................................ 65 

Running ArchestrA Scripts in Embedded Industrial Graphics  ..................................................... 68 

Deploying the InTouchViewApp Object in a Terminal Services Environment  ............................... 69 

Index ......................................................................................................................................... 71 
  





 AVEVA™ InTouch HMI formerly Wonderware InTouch HMI and ArchestrA Integration Guide 

 

 7 
 

Overview 
You can manage your InTouch applications with the InTouch Application Manager or with the ArchestrA 
IDE.  

There are three types of InTouch applications, categorized by how they are managed, the types of 

symbols they support, and where they were published from:  

 Standalone InTouch applications  

 Managed InTouch applications  

 Published InTouch applications  

You can enhance your InTouch applications with graphic objects, the Industrial graphics.  
 

Standalone InTouch Applications 
Standalone InTouch applications are managed by the InTouch Application Manager.  

They appear in the InTouch Application Manager as Standalone. 

Using the Application Manager, you can:  

 Create and manage standalone InTouch applications.  

 Start WindowMaker to edit InTouch applications 

 Start WindowViewer to run InTouch applications.  

You can also switch directly between WindowMaker and WindowViewer to test or run your applications 
and switch back to make modifications to your applications.  

CHAPTER 1 

About InTouch HMI and ArchestrA 

Integration 
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Network Application Development manages the propagation of changes from your InTouch application 
on a development node to running InTouch applications on target nodes.  

Application Manager
(manages InTouch Applications)

WindowMaker
(edits InTouch Applications)

WindowViewer
(tests InTouch Applications)

STARTS STARTS

FAST
SWITCH

Development

Application Manager
(manages InTouch Applications)

WindowViewer
(runs InTouch Applications)

STARTS

Target Nodes

Propagation

Network 
Application 

Development

 
 

Managed InTouch Applications 
You can manage your InTouch applications using the ArchestrA Integrated Development Environment 

(IDE). These applications are called "Managed" InTouch applications. 

They appear in InTouch Application Manager as Managed. 

You develop an InTouch application on one node of the Galaxy with WindowMaker. You then deploy it to 

one or more target nodes running WindowViewer.  

When you use the system platform functionality of the ArchestrA IDE to manage your InTouch 
applications, you can: 

 See which InTouch applications are running on what node. 

 Use a central repository for InTouch applications. 
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 Deploy changes to WindowViewer running on the remote nodes.  

ArchestrAInTouch

WindowMaker

Development

Application Manager WindowViewer

Target Nodes

Bootstrap
&

WinPlatform

Galaxy Name Space
(ArchestrA Attributes)

&
InTouch Application 

Management

Bootstrap
&

WinPlatform

Communication
& Deployment

Configuration

 
 

Published InTouch Applications 
After you edit your managed InTouch application, you can publish it.  

A published application appears in InTouch Application Manager as Published. 

The advantage of published InTouch applications is that they can be distributed like standalone InTouch 
applications, but continue to support the functionality of Industrial graphics.  

However, you can no longer:  

 Use ArchestrA IDE to deploy InTouch applications.  

 Edit or add Industrial Graphics in InTouch applications. 

 Edit the published InTouch application.  
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Application Server Architecture 
Application Server relies on ArchestrA technology to provide services for distributed InTouch HMI 

applications. Application Server services are distributed across a set of nodes with the InTouch HMI 
installed on the Visualization Node to provide the application interface.  

 

An Application Server Galaxy represents the system’s configuration based on a single logical 

namespace that incorporates a variety of components that are distributed across multiple nodes.  

Application Server can store production data similar to InTouch tags, but it supports more data types and 
arrays. It can provide alarm capabilities that are compatible with the InTouch alarm system. Application 

Server provides an InTouch HMI compatible scripting language with significant enhancements for .NET 
function support. To be able to read and write Galaxy data, you need to install the Application Server 
Bootstrap component on the InTouch node. To be able to browse the Galaxy, you need to install the 

Application Server IDE component.  

For more information, see the Application Server documentat ion.  
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Communication within the Galaxy 

ArchestrA enables the use of a Galaxy-wide name space to contain and process production-related data. 

It also allows a high-level visualization and administration of data access from various nodes running 
InTouch in the manufacturing environment.  

ArchestrAInTouch

Application Manager

WindowMaker WindowViewer

Development

Application Manager WindowViewer

Target Nodes

Propagation

Network 
Application 
Development

Bootstrap
&

WinPlatform

Galaxy Name Space
(ArchestrA Attributes)

Bootstrap
&

WinPlatform

Communication

 
 

Industrial Graphic Editor 
In addition to the benefits of managing InTouch applications within the ArchestrA IDE, you can model 
your manufacturing environment by creating graphics with the Industrial Graphic Editor. The Industrial 
Graphic Editor is fully integrated into the ArchestrA IDE and supports powerful graphics editing 

capabilities.  

The Industrial Graphic Editor includes the ability to apply an Element Style to a symbol element. An 
Element Style is a defined set of visual properties for text, element fill, element outlines, and lines that are 

applied to graphic elements. Using Element Styles makes it easy to apply standard visual styles to 
graphic elements and establish consistent symbol standards.  

The Industrial Graphic Editor also includes the Symbol Wizard Editor, which enables you to create 

Symbol Wizards containing different visual and functional configurations. Using the Symbol Wizard 
Editor, you can, for example, create a configurable pump symbol with separate left and right inlet valve 
configurations. Situational Awareness Library symbols are examples of Symbol Wizards containin g 

pre-built configurations that are selected by choosing from the symbol’s Wizard Options. A single 
Situational Awareness Library symbol can be easily configured to represent a thermometer, a flow 
meter, or a pressure meter. You select the configuration you need when the Symbol Wizard is embedded 

in a managed InTouch application.  

WindowMaker incorporates the Industrial Graphic Toolbox to select Industrial and Situational Awareness 
Library symbols for InTouch applications without opening the Industrial Graphic Editor. Symbols can be 

added by dragging and dropping them directly from WindowMaker into an InTouch window. For more 
information about working with Industrial and Situational Awareness Library symbols, see the Industrial 
Graphic Editor User Guide or WindowMaker help.  

Note: In recent versions of Microsoft’s rendering technologies, certain gradient features have been 
deprecated. To accommodate and future proof graphics built using ArchestrA, the affected features have 

been removed from the configuration environment. Graphics previously configured with deprecated 
features will continue to render as expected. See "Loading Graphics with Deprecated Features" from the 
Industrial Graphic Editor User Guide.  



About InTouch HMI and ArchestrA IntegrationAVEVA™ InTouch HMI formerly Wonderware InTouch HMI and ArchestrA Integration Guide 

 

 12  

 

Comparing Standalone, Managed, and Published InTouch 
Applications 

Standalone, managed, and published InTouch applications have some differences and some 
similarities, as described in the following table:  
 

  Standalone 
InTouch 
Applications 

Managed InTouch Applications Published InTouch 
Applications 

Create Application Application 

Manager 

ArchestrA IDE 

 New application 

 Importing standalone 
application 

 Importing SmartSymbols  

Not possible 

Edit Application WindowMaker 
started from the 

Application 
Manager 

WindowMaker started from within 
the IDE 

Not possible 

Delete Application Remove from 

Application 
Manager. 

Delete InTouchViewApp 

template 

Remove from 

Application Manager. 

Support of 

Industrial graphics, 
including Symbol 
Wizards 

Yes Yes for all operations Yes, but only for 

viewing, not for 
creating and editing 

Support of DB 

Dump and DB 
Load 

Yes, function 

within Application 
Manager 

Yes, function within the IDE  Yes, function within 

Application Manager 

Editing application 
in original 
resolution requires 

conversion 

Yes No Yes 

Management of 
Distributed 
Applications  

Network 
Application 
Development 

(NAD) 

ArchestrA IDE Network Application 
Development (NAD) 
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  Standalone 
InTouch 
Applications 

Managed InTouch Applications Published InTouch 
Applications 

Configuring how 

new InTouch 
application 
versions are 

accepted 

Configured in 

Application 
Manager 
(Network 

Application 
Development) 

Configured in WindowMaker Configured in 

Application Manager 
(Network Application 
Development) 

Use Fast-Switch to 

test application 

Yes Yes Yes 

Use tag value and 

tag parameter 
retention 

Yes Yes, also requires configuration 

of the local working directory  

Yes 

 
 

Managing InTouch Applications Using the ArchestrA IDE 
You can manage your InTouch applications using the IDE. The following procedure shows you how to do 

this in a general way. For more specific information, see Managing InTouch Applications with the IDE on 
page 25.  

The InTouch functionality in the ArchestrA IDE is handled by two AutomationObjects: 

 The InTouchViewApp object represents an InTouch application at design time and run time.  

 The ViewEngine object controls how an InTouch application runs on a target node in a Galaxy.  
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The following diagram shows how InTouch applications are managed using the ArchestrA IDE:  

Development NodeArchestrA IDE

WindowMaker WindowViewer

Derive

Derive

Target Node

Deploy

Close (Check In)

Develop, modify and 
test InTouch 
Application

Open (Check Out)

WindowViewerApplication 
Manager

Run InTouch 
Application in 
WindowViewer

$InTouchViewApp

base template

$MyInTouchApp

derived template

MyInTouchApp_001

instance

1

2

3

4

5

6

7

 

To use the IDE to manage your InTouch applications 

1. Create a managed InTouch application in the ArchestrA IDE. 

2. Open it in WindowMaker.  

3. Configure your InTouch application in WindowMaker. You can switch to WindowViewer to test the 

application. 

4. Save the InTouch application and close WindowMaker and WindowViewer.  

5. Determine which nodes to deploy the InTouch application to.  

6. Deploy the InTouch application to the target nodes in the Galaxy. 

7. Run the InTouch application in WindowViewer on the target nodes.  
 

InTouchViewApp Object 

ArchestrA manages your InTouch applications with a specific type of ArchestrA object called the 
InTouchViewApp object. 

An InTouchViewApp template references one specific managed InTouch application at design time and 

cannot be executed at run time.  

You must create an instance of the InTouchViewApp template. This instance can be deployed to a target 
node. The target node is the node on which the managed InTouch application runs in WindowViewer.  

To distribute an InTouch application, you create multiple instances of the same template and deploy 
them to multiple nodes. 

Optionally, you can: 
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 Export and import the InTouchViewApp object to exchange managed InTouch applications across 
Galaxies.  

 Export and import tag dictionary data as .csv files. 

 Export and import windows between different types of InTouch applications. 

 Publish the managed InTouch application. The published InTouch application runs like a standalone 
InTouch application but can contain Industrial Graphics.  

 Use the attributes of the deployed InTouchViewApp object to read from and write to InTouch tags 

with ArchestrA attributes. 

To use the InTouchViewApp object 

1. Derive an InTouchViewApp template from the $InTouchViewApp base template.  

2. Associate the derived template with an InTouch application by creating a new InTouch application or 
importing a standalone InTouch application.  

3. Open the application in WindowMaker. 

4. Configure the application in WindowMaker and test it in WindowViewer.  

5. Save and close WindowMaker. The InTouchViewApp template is checked in.  

6. Derive instances from the InTouchViewApp template. 

7. Deploy these instances to selected target nodes within the Galaxy.  

8. Run Application Manager on the target nodes and run the managed InTouch applications in 

WindowViewer.  
 

Associating an InTouchViewApp Template with an InTouch Application 

After you create a new InTouchViewApp template, you can associate an InTouchViewApp template with 

an InTouch application by:  

 Creating a new InTouch application.  

 Importing a standalone InTouch application.  

The InTouchViewApp template does not contain the InTouch application data itself, such as the tag 

configuration and values, but simply references the application.  
 

Editing a Managed InTouch Application 

You edit a managed InTouch application with WindowMaker as you do for a standalone InTouch 

application, except that you open the editor of the InTouchViewApp template to start the associated 
InTouch application in WindowMaker.  

When you close WindowMaker after making changes to the InTouch application, the InTouchViewApp 

object is automatically checked in.  
 

Testing a Managed InTouch Application 

You can test a managed InTouch application with WindowViewer as you can with standalone InTouch 

applications. 

You can fast switch between WindowMaker and WindowViewer to test a managed application if you 
opened WindowMaker from the ArchestrA IDE. 

If a managed InTouch application contains references to ArchestrA data, such as galaxy:UDA, then a 

WinPlatform object needs to be deployed to the node you are editing the InTouch application on. 
Otherwise, the data shows blank values.  
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Deploying the InTouchViewApp Object 

After you derive an instance of your InTouchViewApp template, you can assign it to the target plat form 

under a ViewEngine object. 

You cannot assign multiple InTouchViewApp instances that have the same parent under one 
ViewEngine. Instead create a second ViewEngine instance to host additional InTouchViewApp 

instances with the same parent.  

 

After you deploy the InTouchViewApp object, you can open the InTouch Application Manager on the 
target node. The associated managed InTouch application appears in the list together with the time 

stamp of its last deployment in the Date Modified column. 

When you deploy the InTouchViewApp instance to a target node, the InTouch application is contained in:  

 A folder on the development node. This contains the source for the InTouchViewApp template.  

 A folder on the target node from which the InTouch application runs. This contains an instance copy 
of the InTouch application. 

 

Exporting and Importing an InTouchViewApp Object  

You can export the InTouchViewApp object. You do this, for example, to use the managed InTouch 

application together with its hosting InTouchViewApp object in other Galaxies.  

When you export the object, a package file (.aaPKG) is created containing informat ion about the object, 
the associated managed InTouch application, and any Industrial graphics the application uses.  

When you import an InTouchViewApp object, the ArchestrA IDE also imports the managed InTouch 
application. 
 

Exporting and Importing Tag Data Associated with a Managed InTouch 

Application 

You can export tag data that is associated with a managed InTouch application to a .csv file. This is 

equivalent to the DB Dump function of the InTouch Application Manager.  

You can import the exported tag data from a .csv file back into a managed InTouch application in the 
same way as the DB Load function.  

The exported .csv files from a managed InTouch application and those of a standalone InTouch 
application are fully interchangeable.  
 

Publishing Managed InTouch Applications 

You can publish a managed InTouch application. The published InTouch application is no longer 
associated with the InTouchViewApp template.  
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The published application cannot be edited within the IDE or imported into another InTouchViewApp 
template. In other words, you cannot manage it with the IDE or republish it.  

The published InTouch application can still communicate with the Galaxy through any embedded 

Industrial graphic. You can, for example, write data back to the Galaxy or visualize Galaxy data.  

You can edit the Industrial graphic using basic InTouch operations such as copying, cutting, pasting, 
duplicating, moving, resizing, flipping, rotating, and configuring with InTouch animation links. 

However, the Industrial graphics cannot be modified, nor can new Industrial graphics be embedded into 
the InTouch application. These operations are only allowed with managed InTouch applications.  

You can do this in environments that do not support the processing requirements of ArchestrA. For 

example, in remote plant operations or in small networks.  
 

Exporting and Importing InTouch Windows between InTouch Applications 

You can export windows from all three InTouch application types from WindowMaker, but there are some 

restrictions on importing exported windows or windows directly from an InTouch application.  

 For standalone InTouch applications, you cannot import any windows from published and managed 
InTouch applications that contain Industrial graphics. A warning message appears, and information 

on which windows were not imported is written to the Logger.  

If you import windows from managed or published InTouch application that contain Industrial 
graphics, the windows are imported, but the Industrial graphics are not functional and appear as "Not 

Found". 

 For managed InTouch applications, you can import any windows from published, stand-alone, and 
other managed InTouch applications. Embedded Industrial graphics are not imported.  

 For published InTouch applications, you can import any windows from standalone InTouch 

applications. Embedded Industrial graphics are not imported.  
 

Attributes of the InTouchViewApp Object  

You can use the ArchestrA attributes of the InTouchViewApp object to access the run-time data of the 

tags of the associated InTouch application. This is useful for reading and writing InTouch data directly in 
the Galaxy name space and provides the same functionality as the InTouchProxy object.  

In this example, a deployed managed InTouch application uses a real tag TankLevel to report the fill level 

of a tank and a discrete tag ValveOut to control the state of a valve.  

To read and write the InTouch tags from the InTouchViewApp object instance 

1. Right -click the deployed InTouchViewApp object, and then click View in Object Viewer. Object 
Viewer appears. 

2. Right -click in the Watch area, and then click Add Attribute Reference . The Add Attribute 

Reference dialog box appears.  

3. In the Attribute Reference box, type the name of the InTouchViewApp object followed by a dot and 
the name of the InTouch tag you want to read or write. For example, TankDemo_001.TankLevel. 

4. Click OK. The attribute is added to the Watch area.  

5. Repeat steps 2 through 4 for any other InTouch tags you want to read or write.  
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6. You can now view the InTouch tag value. 

 

7. To write to an InTouch tag value, do the following: 

a. Double-click it. The Modify Value dialog box appears.  

b. Type a new value and click OK. The value is written back to the tag of the running InTouch 
application. 

 

Differences Between the InTouchViewApp Object and Other AutomationObjects  

The InTouchViewApp object is unlike other AutomationObjects. You cannot perform some operations 
you can normally do with other AutomationObjects. 

 If you try to configure an InTouchViewApp instance, a message appears asking if you want to open 

its parent template instead. You cannot configure the instance directly, only the parent template.  

 If you try to open more than one InTouchViewApp template for configuration at a time on one node, 
IDE prevents you from doing so. Close WindowMaker, WindowViewer, and Application Manager and 

retry. Alternately, you can edit the InTouchViewApp object on a different node with InTouch 
WindowMaker. 

 If you close the IDE while editing an InTouch application with WindowMaker, WindowMaker prompts 
you to save any changes. It then closes and the InTouchViewApp template is checked in.  

 If you close the IDE while testing an InTouch application with WindowViewer, WindowViewer closes.  

If you want to: 

 Change the association between the InTouchViewApp and the InTouch application, create a new 

derived InTouchViewApp template instead.  

 Use ArchestrA security (Galaxy security) in InTouch, deploy a WinPlat form instance to the node on 
which the deployed managed InTouch application is running.  

 

ViewEngine Object 

The ViewEngine is an ArchestrA object that hosts and runs deployed InTouchViewApp objects.  

To deploy an InTouchViewApp instance to a target platform, you need to assign it to a ViewEngine object 
first. The ViewEngine object is then assigned to the target WinPlatform object.  

The ViewEngine fulfils the same functions for the InTouchViewApp instances as the AppEngine instance 
does for the Application Objects. The ViewEngine:  

 Sets up and initializes the InTouchViewApp objects when they are initially deployed and started, so 

that they can communicate with other objects in the Galaxy.  

 Performs diagnostics on attributes that can be monitored, alarmed, and historized.  

 Historizes data to the Historian. 

You can use different ViewEngine objects to: 
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 Historize data to different Historians. 

 Interact with deployed InTouch applications at different scan rates. This sets at which frequency 
InTouch tag data can interact with the Galaxy name space.  

A platform can host multiple ViewEngine objects. Every InTouchViewApp must be assigned to a 
ViewEngine.  

You cannot create multiple instances of the same InTouchViewApp template to run under the same 

ViewEngine object. But you can run multiple instances of the same template under different ViewEngine 
objects. 
 

Industrial Graphics 
The ArchestrA IDE includes a Industrial Graphic Editor to create symbols that represent production 

processes and provide an HMI interface to ArchestrA AutomationObjects.  

The following diagram shows how symbols that are created with the Industrial Graphic Editor can be 
used in InTouch applications.  

 
 

Creating Industrial Graphics 

Industrial Graphics are created with the Industrial Graphic Editor in the IDE.  

You can create: 

 Industrial Graphics in the Industrial Graphic Toolbox. These are not associated with any specific 

ArchestrA object template or ArchestrA object instance. 

 Industrial Graphics contained in a specific ArchestrA object template or instance.  
 



About InTouch HMI and ArchestrA IntegrationAVEVA™ InTouch HMI formerly Wonderware InTouch HMI and ArchestrA Integration Guide 

 

 20  

Embedding Industrial Graphics into InTouch Windows 

Industrial Graphics can be embedded into a managed InTouch application and used.  

You can embed an Industrial Graphic into a window of a managed InTouch application from:  

 The Industrial Graphic Toolbox 

 An ArchestrA object template 

 An ArchestrA object instance 

You embed these objects into InTouch windows by browsing the Galaxy for symbols or 
AutomationObjects. 

  
 

Creating New ArchestrA Object Instances Automatically 

If you embed an Industrial Graphic from a template, the InTouch HMI can create an instance of that 

object and the symbol instance references the new instance.  

The following example shows you how to create a new ArchestrA object instance automatically. 

To create a new ArchestrA object instance automatically 

1. Create an ArchestrA object template $Valve1 and open it in the ArchestrA IDE object editor.  

2. On the Graphics tab, add an Industrial Graphic called ValveSymbol. 

3. Create a derived template of the InTouchViewApp object and open it in WindowMaker.  

4. Create a new InTouch window and embed the Industrial Graphic ValveSymbol from the ArchestrA 

object template $Valve1. WindowMaker prompts you for an instance name.  

5. Type a name, for example Valve1_E122 and click OK. The Industrial graphic is pasted on the 

InTouch window and the AutomationObject instance Valve1_E122 is created in the Galaxy.  
 

Exporting and Importing Industrial Graphics as XML Files 

Use the GraphicAccess application programming interface (API) to export an existing Industrial Graphic 
to an XML file. Use the same API to create an Industrial Graphic in another galaxy or to overwrite an 

existing graphic by importing the graphic definition from an XML file. 

Before using the GraphicAccess API, you must use the ArchestrA GRAccess Toolkit to log in and 
connect to an ArchestrA Galaxy Repository. For more information about logging in and connecting to a 

Galaxy repository, see the GRAccess Toolkit API User’s Guide. 
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Implementing the GraphicAccess API 

The GraphicAccess API is implemented by the ArchestrA.Visualization.GraphicAccess.dll file installed in 

the following folders based on 32-bit or 64-bit versions of Windows: 

 32-bit Windows: \Program Files\ArchestrA\Framework\Bin 

 64-bit Windows: \Program Files (x86)\ArchestrA\Framework\Bin 

IGraphicAccess is an interface that is implemented by the GraphicAccess.dll component. IGalaxy 
returns the galaxy name and is obtained from the GRAccess API, and is used to log in and connect to the 
ArchestrA Galaxy Repository. See the ArchestrA GRAccess Toolk it API User's Guide for further 

information about using GRAccess. 

IGalaxy, graphic name, and the XML file path are passed as parameters to the methods of 
IGraphicAccess. 
 

public interface IGraphicAccess 

{ 

 /// <summary> 

 /// Export an ArchestrA Galaxy graphic to Xml file 

 /// </summary> 

 /// <param name="galaxy">IGalaxy obtained from GRAccess</param> 

 /// <param name="graphicName">The graphic name</param> 

 /// <param name="xmlFilePath">The XML file path</param> 

 /// <param name="bExportSubstituteStrings">Option to export 

SubstituteStrings</param> 

 /// <returns>Result of the method</returns> 

 ICommandResult ExportGraphicToXml(IGalaxy galaxy, string graphicName, 

string xmlFilePath, bool bExportSubstituteStrings); 

} 

If the Galaxy has security enforced, you must first log in to the Galaxy Repository with proper credentials. 
Also, the Can Export Graphics and Can Import Graphics Galaxy role permissions must be set acti ve 

before attempting an import or export operation.  

You can set the Can Export Graphics and Can Import Graphics Galaxy role permissions from the 
ArchestrA IDE Configure Security dialog box. For more information about setting Galaxy permissions, 

see the Application Server User Guide.  
 

Creating Symbol Wizards with the Symbol Wizard Editor 

The Industrial Graphic Editor includes the Symbol Wizard Editor, which can be used to create different 

visual and functional configurations of a symbol. These multi-configuration symbols are called Symbol 
Wizards. An example of creating a Symbol Wizard is a pump symbol that shows the outlet pipe on the left 
or right of the central blade housing. Using the Symbol Wizard Editor, both configurations can be 

included in one Symbol Wizard.  
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Symbols Wizards are not associated with any specific ArchestrA object template or ArchestrA object 
instance. Except for the ability to select a specific symbol configuration, Symbol Wizards behave like 
standard Industrial Graphics. 

The ability to create Symbol Wizards with different configurations reduces the number of required 
symbols that need to be created for an application. Also fewer symbols results in lower maintenance and 
fewer design time issues. 
 

Creating Symbol Wizards 

The process of creating and implementing a Symbol Wizard has two work flows, a Designer workflow 
and a Consumer work flow:  

 A Designer creates multiple configurations of a symbols using the Symbol Wizard Editor.  

 A Consumer selects the appropriate configuration of a Symbol Wizard and embeds the symbol into 
managed InTouch applications. 

 

Symbol Wizard Designer Workflow 

The Designer uses the Symbol Wizard Editor to define the various symbol configurations and assign 
graphic elements, custom properties, and scripts to symbol configurations in the form of layers. Rules are 
assigned with Choice Groups, Choices, and Options that determine when a layer is included in a symbol 

configuration. The Designer selects a configuration to be the symbol default that appears when the 
symbol is embedded in a managed InTouch application.  

After creating all symbol configurations, the Designer verifies how each configuration of a symbol will be 

presented to a Consumer using the Symbol Wizard Preview. Designers use the Wizard Options to 
verify that each configuration appears as designed based on the layer rules set for the symbol.  

 

When a Symbol Wizard is finished, the Designer saves it to the Galaxy library so that it is available to 

embed into managed InTouch applications. 

For more information about creating Symbol Wizards, see the Industrial Graphic Editor User’s Guide.  
 

Symbol Wizard Consumer Workflow 

When a Consumer embeds an instance of a Symbol Wizard into a managed InTouch application, the 
symbol’s default configuration is selected. The Consumer can change the configuration by selecting 
options from the Symbol Wizard’s Wizard Options view. Depending on the selected configuration, there 

can be additional configuration-related properties that can be selected by the Consumer. 
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While the InTouch application is running, the Symbol Wizard appears as the configuration selected by 
the Consumer. A symbol’s configuration cannot be changed during run-time.  

For more information about how to embed Symbol Wizards into a managed InTouch applications, refer 

to Embedding Symbol Wizards on page 47.  
 

Symbol Change Propagation 

Any changes to a source Industrial graphic are propagated to all embedded Industrial graphics. This 

affects the Industrial graphics in WindowMaker and the Industrial graphics inherited by 
AutomationObjects. 

If a change is made to an Industrial graphic and it is used in an open InTouch window, the Symbol 

Changed icon appears in the bottom right corner of the status bar.  

When you double-click this icon, the embedded Industrial graphic is updated with the changes.  

The following example shows you how symbol change propagation works. 

To propagate a symbol change 

1. Follow the example from Creating New ArchestrA Object Instances Automatically on page 20. 

2. In WindowMaker, open the window that shows the Valve symbol. 

3. Open the Industrial graphic ValveSymbol that is hosted by the ArchestrA object template $Valve1.  

4. Make some changes and click Close and Save. The changes are propagated to ArchestrA object 
instance Valve1_E22. In WindowMaker, the Symbol Changed icon appears. 

5. Double-click the icon to accept the changes. The embedded Industrial graphic is updated.  
 

Symbol Dynamic Size Propagation 

You can control the way that size changes of the source symbol are propagated to its embedded 
symbols. For example, a size change is: 

 Resizing one of the elements in the source symbol so that the symbol boundary changes.  

 Adding elements to or removing elements from the source symbol so that the symbol’s boundary 
changes. 

This feature is called dynamic size change propagation and can be enabled or disabled.  

For more information about dynamic size propagation, see the Industrial Graphic Editor User Guide.  
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About Managing InTouch Applications with the IDE 
You can use the ArchestrA IDE to: 

 Create a new managed InTouch application.  

 Import an existing InTouch application to use as a managed InTouch application.  

 Start WindowMaker.  

 Submit the changes you make in WindowMaker to a managed InTouch application.  

 Export and import a managed InTouch application together with its InTouchViewApp object.  

 Publish a managed InTouch application. 

 Delete a managed InTouch application.  

 Import and export tag data used in a managed InTouch application.  

 Export tag data to and import tag data from a .csv file. 

 Switch languages for a Managed InTouch application. 

 Add files to a Managed InTouch application.  

 Associate all Galaxy graphics with an InTouchViewApp. 

 Use an application template to create a Managed InTouch application.  

You can start the ArchestrA IDE from the InTouch Application Manager.  

CHAPTER 2 

Managing InTouch Applications with the 

IDE 
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The following graphic shows how applications are imported, exported, managed, and published.  

 
 

Creating a Managed InTouch Application 
You create a managed InTouch application by creating and configuring an InTouchViewApp object.  

You can also view application version, resolution, and description information directly from the 
InTouchViewApp object. 

The InTouch application directory is created as a share:  

\\GRNodeName\GalaxyName-$InTouchViewAppObjectName 

This directory is managed by the IDE, not by the InTouch Application Manager.  

To create a managed InTouch application 

1. Open the ArchestrA IDE.  

2. In the Template Toolbox , expand the System toolset. 

3. Derive a template from the $InTouchViewApp base template. Do the following:  

a. Right -click the $InTouchViewApp base template, point to New, and then click Derived 
Template. A new derived template appears with a default name. 
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b. Rename the new template if needed.  

 

4. Double-click the derived template. The InTouchViewApp Initialization dialog box appears. 
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5. Select Create New InTouch Application and click Next. The next panel appears. 

 

6. Type a name for the InTouch application and a description.  

7. Select InTouchView Application to create an InTouch application that uses only ArchestrA 

references as an external data source.  

8. Select the application target resolution if different than the default screen resolution option. Options 
for this field are as follows: 

a. Click the Select target resolution dropdown menu to view a list of predefined target resolutions.  

b. Click the Select target resolution dropdown menu and select Custom. The Pixel width and 
height fields becomes editable. The boundary limits are 150x150 and 10000x10000.  

9. Click Next. WindowMaker starts. 

Note: If you have selected a target resolution that is different from the screen resolution, you will not be 

prompted to convert to screen resolution upon editing the application in WindowMaker.  

To view application version, resolution, and description 

1. Open the Template Toolbox. 

2. Right -click the InTouchViewApp template, and then click Application Information. The 
Application Information dialog box appears.  
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To Change Target Resolution 

You can change the specified target resolution while editing the application in WindowMaker. This 
functionality is not available for command line.  

Do the following:  

1. Click Special, Configure, and select Target Resolution.  

The Target Resolution dialog box appears. 

 

2. Edit the target resolution as needed and click OK. 

The boundary canvas updates to reflect the change. Windows, window size and window controls will 
remain the same.  

Note: The Show target resolution boundary canvas is checked by default.  

 

Creating a Managed Application from an Application Template 
Creating a Managed InTouch application based on an application template enables you to significantly 
reduce design time and base your new application on existing standards.  

You select which template you want to base your Managed InTouch application on using the Application 

Template Browser. The templates available in the Application Templates Browser are exported .aaPKG 
files that are loaded from an Application Templates folder in the InTouch installation directory. For 
example:  
C:\Program Files(x86)\Wonderware\InTouch\ApplicationTemplates 

The folder hierarchy in the Application Templates Browser will mimic the hierarchy in this directory.  

To create a Managed application based on an application template: 

1. Open the ArchestrA IDE and create a derived template from the $InTouchViewApp object.  

You can optionally rename the derived template. 

2. Double-click the derived template.  
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The InTouchViewApp Initialization dialog box appears. The Create new InTouch application 
option is selected by default. 

 

3. Select the Use application template  checkbox. 
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The Click to select application template  command button becomes enabled. Upon click, the 
Application Template Browser displays. 

 

The left pane displays a tree view of the application template folders. The right pane displays 

thumbnail previews of the contents of the selected folder.  

Each thumbnail in the browser maintains its aspect ratio.  

4. Select your preferred application template and click OK. 

Your selection will be populated in the InTouchViewApp Initialization dialog box.  

5. Carefully review and select your preferred galaxy settings overwrite options.  

Note: The Overwrite the contents and settings of this galaxy with those from the application 

template option is selected by default. The specific galaxy settings that will be overwritten are broken 
down in the child options. Any or all of these options can be unchecked at this time.  

The overwrite options are as follows: 

o Overwrite Industrial graphics 

If selected, galaxy symbols will be replaced by application template symbols in case of conflict.  

o Overwrite galaxy style library 

If selected, the application template style library will replace the entire galaxy style library. If 

unselected, this step will be skipped. There is no merge of style libraries.  

o Overwrite script function library 

If selected, the galaxy script function library will be replaced by the application template script 

library in case of conflict. 

o Overwrite client controls 
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If selected, a galaxy client control will be replaced by the application template client control in 
case of conflict. 

o Overwrite languages 

If selected, the language settings defined in the application template will replace those defined in 
the galaxy.  

If unselected, the galaxy language settings will remain in case of conflict. If unselected and no 

conflicts occur, the application template language settings will append to the galaxy settings. 

6. Click Next. 

If you selected the Backup current galaxy option, you will be prompted for the location of the file 

name of the backup .cab file.  

Important: It is highly recommended to back up your galaxy. 

7. Confirm your application name and select InTouchView Application. 

The target resolution is set to the resolution of the template by default. The Pixel fields are disabled. 

This can be adjusted during application development. 

8. Click Next. 

When initialization completes, you can deploy your application.  
 

Starting WindowMaker from the ArchestrA IDE 
You can edit a managed InTouch application by starting WindowMaker from within the ArchestrA IDE.  

You can start WindowMaker from an InTouchViewApp template or an instance.  

When opening a managed InTouch application created with a different screen resolutio n than your 
current system resolution, a message appears. 

 

 Click Yes to convert the InTouch application to the current system resolution and open it.  

 Click No to open and edit the InTouch application in its original resolution.  

To start WindowMaker from an InTouchViewApp template 

1. Open the ArchestrA IDE.  

2. Locate the InTouchViewApp template that includes the managed InTouch application you want to 
modify. 

3. Double-click the InTouchViewApp template. WindowMaker starts as the object’s default editor and 
opens the InTouch application. You are ready to edit the managed application.  

To start WindowMaker from an InTouchViewApp instance 

1. Open the ArchestrA IDE.  
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2. Locate the InTouchViewApp object whose parent hosts the managed InTouch application you want 
to modify.  

3. Double-click the InTouchViewApp object. The InTouchViewApp Instance Edit dialog box appears. 

 

4. Do any of the following:  

o Click No to not open the template.  

o Click Yes to open the associated InTouchViewApp template in WindowMaker.  

If you select the Don’t ask me again check box and click Yes, the next time you open an 
InTouchViewApp instance, the managed InTouch application is automat ically opened from the 
associated InTouchViewApp template.  

You can change this setting using the Configure User Information dialog box, which you open 
from the Edit menu.  

 
 

Submitting Changes for an InTouch Application 
After you modify your managed InTouch application, you can submit the changes for deployment to t he 
target nodes.  

After you make changes to a managed InTouch Application, any derived InTouchViewApp objects 

appear with the Pending Changes icon.  

This indicates that you must redeploy the changes to the target nodes, for WindowViewer on those 
nodes to reflect the changes. 

For more information on how to deploy the changes to the operator nodes, see Deploying a Managed 
InTouch Application on page 64 and Accepting New Application Versions at the Operator Node on page 
65.  

To submit the changes for an InTouch application 

1. Modify your managed InTouch application in WindowMaker as you would with a standalone InTouch 
application. 

2. Save your InTouch windows.  

3. On the File menu, click Exit. WindowMaker closes and the focus returns to IDE. The Check In 
dialog box appears. 
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4. Type a comment for check in, i f necessary and click OK. The Check In progress dialog box appears. 

5. Click Close. 
 

Importing an InTouch Application 
You can import an existing InTouch application to use as a managed InTouch application. You do this in 
two steps: 

 Create an InTouchViewApp object to associate with the imported InTouch application.  

 Import the InTouch application.  

The imported InTouch application becomes a managed InTouch application.  

The ArchestrA IDE creates a copy of the existing InTouch application in a folder that it manages. The IDE 
leaves the existing InTouch application and location unchanged.  

If the version of the InTouch application you are importing is 6.0 or above, a conversion message 
appears. The application is converted before it is opened in WindowMaker. InTouch applications 
versions before 6.0 cannot be converted.  

To import an InTouch application into a Galaxy 

1. Open the ArchestrA IDE.  

2. In the Template Toolbox , derive a template from the $InTouchViewApp base template.  
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3. Open the derived template. The InTouchViewApp Initialization dialog box appears. 
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4. Click Import Existing Application and click Next. The next panel appears.  

 

5. Locate the InTouch application. Do any of the following:  

o Click the ellipsis button to browse for the folder that contains the managed InTouch ap plication.  

o To search for the application, select the Find applications check box. Specify a search root for 
the search to begin and click Find. Select the InTouch application from the list. 

6. Click Next. The next panel appears.  

 

7. If needed, type a new name in the Application Name box and a description in the Description box. 
The name and description appear in the Application Manager when the managed InTouch 
application is deployed.  

8. Select the application target resolution different than the default screen resolution option. Options for 
this field are viewable as follows:  
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a. Click the Select target resolution dropdown menu to view a list of predefined target resolutions.  

b. Click the Select target resolution dropdown menu and select Custom. The Pixel width and 
height fields will become editable.  

Note: If a different target resolution is selected when importing an existing application, then there 
will be no application resolution conversion from the source application resolution to the target 

resolution.  

9. Click Next. The next panel appears and shows you the import progress.  

 

10.  Click Close. InTouch WindowMaker is started and you can edit the InTouch application as a 
managed InTouch application.  

 

Importing and Exporting an InTouchViewApp Object 
You can import and export the InTouchViewApp object in the ArchestrA IDE. The InTouchViewApp 
object contains all information for hosting a managed InTouch application and can be used to exchange 
a managed InTouch application between Galaxies.  

For more information about importing and exporting AutomationObjects, see the Application Server 
documentation. 

To import an InTouchViewApp object 

1. On the Galaxy menu, point to Import, and then click Object(s). The Import Automation Object(s) 
dialog box appears. 

2. Select the ArchestrA package (.aaPKG) file that contains the InTouchViewApp object you want to 
import and click Open. The object and its managed InTouch application are imported.  

3. Click Close. 

To export an InTouchViewApp object 

1. On the Galaxy menu, point to Export, and then click Object(s). The Export Automation Object(s)  
dialog box appears. 

2. Select a folder to export to, specify an ArchestrA package (.aaPKG) file name and click Save. The 

object and its managed InTouch application are exported.  

3. Click Close. 
 

Publishing a Managed InTouch Application 
You can publish a managed InTouch application from the InTouchViewApp object that is associated with 
it. 

The export consists of a folder containing information about the object an d the managed InTouch 

application. 

This is different than exporting the InTouchViewApp object itself. For more information, see Importing 
and Exporting an InTouchViewApp Object on page 37.  
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The published InTouch application cannot be reimported into an InTouchViewApp object. A published 
InTouch application cannot be edited.  

To publish a managed InTouch application 

1. Open the ArchestrA IDE.  

2. Locate the InTouchViewApp object that contains the managed InTouch application you want to 
publish.  

3. Right -click the object, and then click Publish InTouch Application. The Browse For Folder dialog 

box appears. 

 

4. Specify the folder to publish to the InTouch application to. Do any of the following:  

o Browse to an existing folder.  

o Click Make New Folder to create a new folder or folder structure.  

5. Click OK. The Publish InTouch Application progress dialog box appears.  

 

6. When publishing is complete, click Close. A directory containing the new published InTouch 
application is created in the selected folder. You can now copy it to any run-time node.  

 

Deleting a Managed InTouch Application 
You can delete an InTouch application in the ArchestrA IDE by deleting the associated InTouchViewApp 
template.  

When you do this, the template and the InTouch application directory associated with that template are 
deleted completely. 

You can only delete an InTouch application if the associated InTouchViewApp object does not have any 

derived instances.  
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Deleting an InTouchViewApp instance does not delete the associated InTouch application.  

To delete the InTouchViewApp template 

1. Open the ArchestrA IDE.  

2. Select the InTouchViewApp template that contains the managed InTouch application you want to 

delete.  

3. On the Edit menu, click Delete. The Delete dialog box appears. 

4. Click Yes. The InTouchViewApp template and the associated InTouch application folder are deleted.  
 

Exporting and Importing Tag Data 
You can export the tag data of a managed InTouch application to a .csv file. You can import this data into 
another managed InTouch application or a stand-alone InTouch application.  

To export tag data from a managed InTouch application 

1. Open the ArchestrA IDE.  

2. Select the derived InTouchViewApp template that contains the managed InTouch application from 
which you want to export the tag data.  

3. On the Galaxy menu, point to Export, and then click DB Dump. The CSV File to Dump To dialog 

box appears. 

4. Specify a location and file name for the .csv file and click Save. A confirmation dialog box appears. 

5. Select Group output by types if you want the tag data to be grouped by data types in the .csv file.  

6. Click OK. When a success message appears, click OK. 

To import tag data from a .csv file to a managed InTouch application 

1. Open the ArchestrA IDE.  

2. Select the derived InTouchViewApp template that contains the managed InTouch application to 

which you want to import the tag data.  

3. On the Galaxy menu, point to Import, and then click DB Load. The CSV File to Load From dialog 
box appears. 

4. Select the .csv file and click Open. 

During the import, one or more messages may appear warning you of duplicate names. Select the 
appropriate option for each duplicate tag.  

5. When a success message appears, click OK. 
 

Retaining Tag Value and Parameters 
When you use multiple managed InTouch applications on one node, all applications use the same 
directory. If you configure tag data or parameters to be retained and you switch applications, the run-time 

data is lost. 

To configure retention in a managed InTouch application 

1. Open the managed InTouch application with WindowMaker from the IDE.  

2. On the Special menu, point to Configure, and then click WindowViewer. The WindowViewer 

Properties dialog box appears. 

3. Click the Managed Application tab. 
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4. In the Local Working Directory box, type the name of a unique existing directory. This is the name 
of the directory on the target run-time node. You can also use special characters to specify the local 
working directory path. The following table illustrates the special characters that you can use:  

 

Special Character Local Working Directory Path 

%SystemDrive% System drive. For example, "C:" 

%USER% Name of the logged-on user. If WindowViewer is 
running as a service, the application is copied to 

"All Users" 

%APPDATA% Logged-on user's Application Data. If 
WindowViewer is running as a service, the 

application is copied to "All Users" Application 
Data 

%ITUSER% Logged-on user. If WindowViewer is running as 

a service or in a console session, the application 
is copied to "All Users" 

%ITAPPDATA% Logged-on user's Application Data. If 
WindowViewer is running as a service or in a 
console session, the application is copied to "All 

Users" Application Data 

  
 

Language Switching for a Managed InTouch Application 
For managed InTouch applications, certain language switching functionality is handled by the ArchestrA 
IDE instead of the InTouch HMI.  

Use the ArchestrA IDE to:  

 Export and import graphic text for translation.  

 Configure the language used by the managed application.  

For more information, see the Application Server User’s Guide, Chapter - Working with Languages. 
 

Adding Files for a Managed InTouch Application 
Using WindowMaker you can add files to a managed InTouch application so that they are deployed and 
available at run time.  

To add files to a managed InTouch application 

1. Open the managed InTouch application in WindowMaker.  

2. On the File menu, click Open Application Folder. The standard Windows Explorer window appears 

showing the InTouch application folder on the Galaxy Repository node.  

3. Add new files and folders to the InTouch application folder.  

4. Close the Explorer window.  
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Associating All Galaxy Graphics in an InTouchViewApp 
Associating all Galaxy graphics with an InTouchViewApp template enables deployed and published 

InTouch applications to execute "show graphic" requests made of any graphic in the Galaxy without 
having to embed them in the application.  

 The ShowGraphic() function uses the graphic as a parameter. Associating all Galaxy graphics 

ensures that the graphic is deployed and available at run time whether or not it is referenced by 
InTouchViewApp.  

 Associating all Galaxy graphics ensures that template symbols referenced by the ShowGraphic() 

function are deployed and available at run time. 

Note: The term "graphic" includes any symbol or client control present in the Graphic Toolbox, and any 

symbols owned or inherited by templates and instances. 

For more information about associating all Galaxy graphics with an InTouchViewApp, see the 

Application Server User’s Guide, Chapter 6, "Deploying and Running an Application".  

Access the "Include all Galaxy graphics" option through the InTouchViewApp right-click context menu. 

To include all Galaxy graphics with your InTouchViewApp template 

1. Right -click the InTouchViewApp template you wish to configure. The InTouchViewApp context menu 
appears. 

2. Select the Associate Galaxy Graphics menu item. The Associate Galaxy Graphics dialog box 
appears. 

 

When the Associate Galaxy Graphics dialog appears, the $InTouchViewApp template is checked 

out. 

If the $InTouchViewApp template is not yet initialized or checked out, the Include all Galaxy 
graphics with this application check box is not available.  

3. Click the check box and click OK. A status box displays check in progress. 

If an InTouchViewApp instance is deployed when you attempt to modify the Include all Galaxy 
graphics setting, you will see an information message to undeploy all deployed instances. 
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About Using Industrial Graphics in WindowMaker 
You can use Industrial Graphics created with the Industrial Graphic Editor in your managed or 
standalone InTouch applications. You can also add Industrial Graphics directly from WindowMaker’s 
Industrial Graphic Toolbox. For more information about working with Industrial Graphics and Situational 

Awareness Library symbols, see the Industrial Graphic Editor User Guide or WindowMaker help.  

 

You can:  

 Embed Industrial Graphics into an InTouch window.  

 Drag and drop Industrial Graphics directly from the Industrial Graphics Toolbox into an InTouch 
window.  

 Resize embedded Industrial Graphics. 

 Add a limited number of InTouch animations to Industrial Graphics.  

 Configure the custom properties of embedded Industrial Graphics.  

 Start the Industrial Graphic Editor.  

 Test the Industrial Graphics in WindowViewer.  

 Create a new Instance of the AutomationObject that hosts the embedded Industrial Graphic.  
 

CHAPTER 3 

Using Industrial Graphics in WindowMaker 
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Embedding Industrial Graphics into an InTouch Window 
You can embed an Industrial Graphic into InTouch windows of your managed and standalone InTouch 

application. 

The Industrial Graphic can be part of: 

 The Graphic Toolbox. 

 An ArchestrA object template. 

 An ArchestrA object instance. 

The Industrial Graphics that can be embedded include symbols whose elements have Element Styles 
applied to them and Symbol Wizards created using the Symbol Wizard Editor.  

You can publish a managed InTouch application containing Industrial Graphics in the published 
application. However, you cannot add new Industrial Graphics or edit existing symbols in an application 
that has been published. 
 

Embedding Industrial Graphics from Automation Templates 

You can embed an Industrial Graphic from an Automation template that hosts Industrial Graphics. At the 
same time, a new derived instance of the selected template is created.  

For information about creating a new instance based on an Industrial Graphic already on the InTouch 
window, see Testing Industrial Graphics in WindowViewer on page 60.  

To embed an Industrial Graphic from an Automation template 

1. Open WindowMaker.  

2. On the Edit menu, click Embed Industrial Graphic. The Galaxy Browser dialog box appears.  

3. Click the Template Toolbox icon. The Template Toolbox  list appears on the left. 

 

4. Select the template that contains the Industrial Graphic you want to embed. The Industrial Graphics 
contained in the selected template appear on the right.  

5. Select the Industrial Graphic you want to embed and click OK. The Galaxy Browser closes and the 
insertion icon appears if the pointer is over the InTouch window.  
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6. Click in the InTouch window where you want to embed the Industrial Graphic. The Create Instance 
dialog box appears. 

 

7. In the Instance Name box, type a name for the instance.  

8. Click OK. An instance is automatically derived from the template with the name you specify. The 
symbol is embedded into the InTouch window.  

 
 

Embedding Industrial Graphics from Instances 

You can embed Industrial Graphics from instances that have Industrial Graphics associated with them.  

When you embed an Industrial Graphic from an instance, the symbol is associated with that instance.  

To embed an Industrial Graphic from an instance 

1. Open WindowMaker.  

2. On the Edit menu, click Embed Industrial Graphic. The Galaxy Browser dialog box appears.  

3. Click the Instances icon. The Instances list appears on the left.  

 

4. Click on the instance that contains the Industrial Graphic you want to embed. The Industrial Graphics 

associated with the selected instance appear on the right.  

5. Click on the Industrial Graphic you want to embed and click OK. The Galaxy Browser closes and the 
insertion icon appears if the pointer is over the InTouch window.  
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6. Click in the InTouch window where you want to embed the Industrial Graphic. The symbol is 
embedded into the InTouch window. 

 
 

Embedding Industrial Graphics from the Graphic Toolbox 

You can embed Industrial Graphics from the Graphic Toolbox.  

To embed an Industrial Graphic from the Graphic Toolbox 

1. Open WindowMaker.  

 

2. On the Edit menu, click Embed Industrial Graphic. The Galaxy Browser dialog box appears.  

 

3. Click the Graphic Toolbox icon. The Graphic Toolbox list appears on the left. 

 

4. Select the Industrial Graphic you want to embed and click OK. The insertion icon appears if the 
pointer is over the InTouch window.  

5. Click in the InTouch window where you want to embed the Industrial Graphic. The symbol is 
embedded into the InTouch window. 
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Embedding Industrial Graphics with Element Styles Applied 

You can embed Industrial Graphics that have Element Styles applied to them. An Element Style defines 

one or more of the fill, line, text, blink, and outline properties of a graphic.  The visual properties defined in 
an Element Style are applied to the graphic. Element Styles make it easy to apply consistent styles to 
elements. Element Styles also establish visual standards for screen builders and others who create 

symbols. 

An Industrial graphic that has an Element Style applied to it is embedded into an InTouch window just like 
any other Industrial Graphic.  

For more information about using Element Styles with Industrial Graphics, see Chapter 7, Working with 
Element Styles, in the Industrial Graphic Editor User Guide.  
 

Embedding Symbol Wizards 

You can embed Symbol Wizards into a window of a managed InTouch application from the ArchestrA 
IDE.  

To embed a Symbol Wizard 

1. Open WindowMaker and show the window that will contain the embedded symbol.  

 

2. On the Edit menu, click Embed Industrial Graphic. The Galaxy Browser dialog box appears.  

 

3. Click the Graphic Toolbox icon. The Graphic Toolbox list appears on the left. 

4. Select the Symbol Wizard you want to embed into an application and click OK. 

5. Click in the InTouch window where you want to embed the Symbol Wizard. The symbol is embedded 
into the InTouch window using its default Symbol Wizard configuration.  

 

Resizing Embedded Industrial Graphics 
After embedding an Industrial Graphic into an InTouch window, you can resize it with its handles or with 

the width and height value entry as you would with any other InTouch object. 

However, if the Industrial Graphic contains at least one rotated element, you can only resize the 
Industrial Graphic proportionally. 
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You cannot resize the embedded Industrial Graphic smaller than its minimum size. The minimum size 
may be determined by the pen width of a contained element.  

You can reset the embedded Industrial Graphic to its original size when it was created in the Industrial 

Graphic Editor.  

To resize an embedded Industrial Graphic 

1. Select the Industrial Graphic so that the handles appear.  

2. Do one of the following: 

o Drag the one of the handles to resize the Industrial Graphic to the new size.  

o Enter width and height in the W and H boxes on the status bar.  

To resize an embedded Industrial Graphic to its original size 

 Right -click the embedded Industrial Graphic you want to change to its original size, point to 
Industrial Graphic, and then click Symbol - Original Size. The embedded Industrial Graphic is 

changed to its original size. 
 

Configuring Industrial Graphics in WindowMaker 
You can configure embedded Industrial Graphics in WindowMaker by:  

 Standard editing, such as copying, cutting, pasting, duplicating, resizing, moving, and deleting.  

 Setting up WindowMaker animation links. 

 Connecting an Industrial Graphic with InTouch tags. 

 Selecting an alternate instance of the same parent. 

 Selecting an alternate symbol of the same instance.  

 Enabling or disabling dynamic size propagation.  
 

Configuring WindowMaker Animation Links of an Industrial Graphic 

You configure WindowMaker animation links of an embedded Industrial Graphic in the same way as any 

other InTouch object. You can only configure animation links that are external to the embedded Industrial 
Graphic, such as: 

 Object size 

 Object location 

 Visibility 

 Enablement  

The animation links configured in WindowMaker are independent from those configured in the Industrial 
Graphic Editor. They do not inherit the settings of the Industrial Graphic and take precedence when run 

in WindowViewer.  

To configure WindowMaker animation links of an embedded Industrial Graphic 

1. Select the embedded Industrial Graphic. 
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2. On the Special menu, click Animation Links. The Animation Links dialog box appears. 

 

3. Make any changes as you would to any other InTouch object.  

4. Click OK. 
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Connecting Industrial Graphics to InTouch Tags 

You can connect Industrial Graphics to InTouch tags by overriding the custom properties of an 

embedded Industrial Graphic. Custom properties expose the properties of an Industrial Graphic to 
InTouch. Custom properties may or may not be used int ernally by the animations of the Industrial 
Graphic. 

 

When you embed an Industrial graphic into an InTouch window, the references in the animation links are 
converted, as shown in the following table:  
 

Industrial Graphic Embedded Industrial Graphic 

Object.Extension galaxy:Object.Extension 

intouch:Tagname Tagname 
 

For more information about custom properties, see the Industrial Graphic Editor User Guide. 



Using Industrial Graphics in WindowMakerAVEVA™ InTouch HMI formerly Wonderware InTouch HMI and ArchestrA Integration Guide 

 

 51  

You can select InTouch tags directly from the Galaxy Browser when working within the animation editor 
or the script editor. When invoked from either of those editors, the Galaxy Browser lists all 
InTouchViewApp instances for the current Galaxy, and lists all InTouch tags and dot fields for t he 

selected InTouchViewApp instance. 

For more information about using the Galaxy Browser to select InTouch tags, see Browsing Application 
Server Object Attributes from InTouch.  

To connect an Industrial Graphic to an InTouch tag 

1. Right -click the embedded Industrial graphic in the InTouch window, point to Industrial Graphic, and 
then click Edit Symbol Properties. The Edit Symbol Properties dialog box appears. 

 

2. Select the custom property you want to connect to an InTouch tag. The configuration for the selected 

custom property appears in the right pane.  

3. In the Default Value box, do one of the following: 

o Type the name of the InTouch tag.  

o Click the browse button and select a tag from the Select Tag dialog box.  

 

4. To restore the original value of the custom property, click Restore. 

5. Click OK. Any animation in the Industrial Graphic that is configured with the selected custom 
property now uses the InTouch tag value during processing.  

 

Example of Connecting Industrial Graphics to InTouch Tags 

This example shows you how to connect a tank symbol with a percent vertical fill animation created by 
the Industrial Graphic Editor to an InTouch tag.  

You do this in three main steps: 

 Create a sample Tank as an Industrial Graphic.  

 Create the InTouch application. 

 Derive and view the sample tank in WindowViewer.  
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To create a sample Tank as Industrial graphic 

1. In the IDE, create a new symbol called "Tank" and open it in the Industrial Graphic Editor.  

2. Paste a rectangle on the canvas. Change its appearance as needed.  

3. Create a colored polygon element that represents a cutout of the tank to show the tank level.  

 

4. Click on the canvas. On the Special menu, click Custom Properties. The Edit Custom Properties 
dialog box appears. 

5. Add a custom property called Level.  

6. Configure the property details. Do the following:  

o In the Data Type list, click Float. 

o In the Default Value box, type 0. 

 

7. Click OK. 

8. Double-click on the polygon element that represents the tank level. The Edit Animations dialog box 
appears. 

9. Add a % Vertical Fill animation.  
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10.  In the Analog box in the right pane, type the name of the custom property. In this example, it is Level.  

 

11.  Click OK to close the Edit Animations dialog box. 

12.  Click Close and Save to close the Industrial Graphic Editor.  

To create the InTouch application 

1. In the ArchestrA IDE, create a new managed InTouch application. For more information, see 
Creating a Managed InTouch Application on page 26.  

2. Open the managed InTouch application in WindowMaker.  

3. Create a new window called TankDisplay. 

4. Open the Tagname Dictionary and create a new real InTouch tag named TankLevel.  

5. Click the Embed Industrial Graphic icon. The Galaxy Browser dialog box appears.  

6. Select the Tank symbol and click OK. 

7. Click in the window at the new location to embed the symbol. The Tank symbol is embedded into the 
window.  

 



Using Industrial Graphics in WindowMakerAVEVA™ InTouch HMI formerly Wonderware InTouch HMI and ArchestrA Integration Guide 

 

 54  

8. Right -click the embedded Industrial Graphic, point to Industrial Graphic "Tank", and then click Edit 
Symbol Properties. The Edit Symbol Properties dialog box appears. 

 

9. Select the custom property Level.  

10.  In the Default Value box, type TankLevel. You can also click the ellipsis button to browse for 

TankLevel using the Select Tag dialog box. 

11.  Click OK. 

12.  Paste a slider on the window and configure it with the local InTouch tag TankLevel.  

13.  Save the changes and close WindowMaker. The managed InTouch application is automatically 

checked in. 

To derive and test the sample tank 

1. In the ArchestrA IDE, derive an instance of the managed InTouch application and deploy it together 
with a WinPlatform and a ViewEngine instance.  

2. Open the InTouch Application Manager and start the listed application in WindowViewer. The tank 
and the slider appear on the window in WindowViewer.  

3. You can move the slider to change the tank level. 
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Selecting Alternate Instances from the Same Parent 

You can redirect all references in the Industrial Graphic to an alternate instance. The appearance of the 

Industrial Graphic does not change, except possibly for its size, as it is not possible to edit inherited 
Industrial Graphics. 

You cannot use this function with Industrial Graphics that originate from the Graphic Tool box, as they are 

not associated with any object. 

To select an alternate instance from the same parent 

1. Right -click the embedded Industrial Graphic, point to Industrial Graphic, and then click Select 
Alternate Instance. The Galaxy Browser dialog box appears. It shows all other instances that have 

the same parent. 

 

2. Select an alternate instance from the list and click OK. The references of the Industrial Graphic are 
updated to point at the new alternate instance.  

 

Selecting Alternate Symbols of the Same Instance 

You can replace an embedded Industrial Graphic with another Industrial Graphic belonging to the same 
instance. 

You cannot use this function with Industrial Graphics that originate from the Graphic Toolbox, as they are 

not associated with any object. 

To select an alternate Industrial Graphic from the same instance 

1. Right -click the embedded Industrial Graphic, point to Industrial Graphic, and then click Select 
Alternate Symbol. The Galaxy Browser dialog box appears.  

 

2. Select an alternate symbol in the right pane and click OK. 

3. If the alternate symbol is a different size than the original symbol, a message appears prompting if 
you want to keep the size of the currently embedded Industrial Graphic. Do any of the following:  

o Click Yes to keep the current size of the selected Industrial Graphic.  

o Click No to update the size of the selected Industrial Graphic to the size of the new Industrial 
Graphic. 
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In both cases, the embedded Industrial Graphic is updated with the new alternate Industrial Graphic.  
 

Substituting Strings in Industrial Graphics 

You can substitute all strings in an embedded Industrial Graphic with alternate strings.  

To substitute all strings in an embedded Industrial Graphic 

1. Select the embedded Industrial Graphic. 

2. On the Special menu, point to Substi tute, and then click Substi tute Strings. The Substi tute 
Strings dialog box appears. 

3. Type new strings in the corresponding boxes and click OK. The strings in the embedded Industrial 
Graphic are substituted by the new alternate strings. 

 

Substituting References in Industrial Graphics 

You can substitute all references in an embedded Industrial Graphic with alternate references.  

To substitute all references in an embedded Industrial Graphic 

1. Select the embedded Industrial Graphic. 

2. On the Special menu, click Substitute Tags. The Substitute Tags dialog box appears. 

3. Type new references in the corresponding boxes and click OK. The references in the embedded 

Industrial Graphic are substituted by the new alternate references.  
 

Enabling or Disabling Dynamic Size Change Propagation of 

Embedded Industrial Graphics 

You can enable or disable the dynamic size change propagation of embedded Industrial Graphics.  

If the dynamic size change propagation is enabled, any change to the absolute anchor point position of 
the source symbol:  

 Leaves the anchor points of its embedded symbols unchanged.  

 Moves the embedded symbol position accordingly.  

If the dynamic size change propagation is disabled, any change to the absolute anchor point position of 

the source symbol:  

 Moves the anchor points of its embedded symbols accordingly.  

 Leaves the embedded symbol position unchanged.  

For more information about dynamic size propagation, see the Industrial Graphic Editor User Guide.  

To enable or disable dynamic size change propagation of an embedded symbol  

 Right -click the embedded Industrial Graphic, point to Industrial Graphic, and then check or 
uncheck Dynamic Size Change . 

 

Associating Scripts with ArchestrA Symbols 

You can associate scripts with the ArchestrA symbols placed in your InTouch applications. Scripts will 

animate your symbols or modify their elements while an InTouch application is running.  
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After selecting an ArchestrA symbol embedded in an InTouch window, you select the expression or 
reference whose value triggers the script to run. You use the ArchestrA Symbol Editor to select the 
trigger that runs the script. 

 

 A symbol script can be either predefined or named. A predefined script runs based on the status of 
the symbol in the running application. A named script runs when an expression or references 
associated with the script changes state. 

 Predefined scripts are similar to InTouch HMI window scripts. Based upon how you configure the 

script trigger, a predefined symbol script can run: 

o Once after the symbol opens or is shown. 

o Periodically while the symbol appears in the running application.  

o Once after the symbol closes or is hidden. 

 Based upon how you configured the script, a named symbol script can run when the trigger values or 
expressions are true, false, or transitioning between true and false states. Also, a named symbol 

script can run when data associated with the trigger expression changes value or its quality state 
changes value.  

 

Using Methods in ArchestrA Symbol Scripts 

Some ArchestrA elements support script methods. These methods can perform various functions on the 

elements themselves at run time. Typically, you configure an action script to access these methods. 
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You can see the supported properties and methods of any ArchestrA element by opening the Galaxy 
Browser and selecting the element. 

 

 You can run a script containing an Edit Box control method to load text from a file to the control 
during run time. You can also run a script to save the current contents of the Edit Box control to a file 
during run time.  

 Edit Box control methods are declared in scripts in the following form:  
ControlName.SaveText(FileName); 

where ControlName is the name of the Edit box control and FileName is the name of the file 
containing the contents of the control to be loaded or saved. In the example above, SaveText is the 

name of the method to save the contents of the Edit Box control to a file.  

 You can use a script containing the methods of the Combo Box and List Box controls to change the 
contents of their lists during run time. List items can be added, deleted, or modified.  

 Combo Box and List Box control methods are declared in scripts similar to the Edit Box control.  
 

Editing Industrial Graphics in the Industrial Graphic Editor 
You can edit embedded Industrial Graphics using the Industrial Graphic Editor that is integrated in the 
ArchestrA IDE. You do this by: 

1. Opening the embedded Industrial Graphic in Industrial Graphic Editor, modifying the symbol, and 
then saving it. The Industrial Graphic is updated in the template, instance or in the Graphic Toolbox.  

For more information, see Editing an Embedded Industrial Graphic  on page 58.  

2. Accepting the changes in WindowMaker by clicking on the Symbol Changed icon in the right bottom 
corner of the status bar. The changes are then propagated to WindowMaker.  

For more information, see Accepting Symbol Changes in WindowMaker on page 59.  
 

Editing an Embedded Industrial Graphic 

You can easily edit an embedded Industrial Graphic from within InTouch WindowMaker.  

If the source symbol or its embedded symbols are used by other managed InTouch applications, the 
changes are propagated to the embedded symbols and the InTouch applications.  

Any changes you make to the Industrial Graphic are not propagated to the embedded Industrial Graphics 
automatically. For more information, see Accepting Symbol Changes in WindowMaker on page 59.  
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To edit embedded Industrial Graphics using the Industrial Graphic Editor 

1. Right -click the embedded Industrial Graphic, point to Industrial Graphic, and then click Edit 
Symbol. The Industrial Graphic Editor with the Industrial Graphic appears. 

 

2. Edit the Industrial Graphic. For more information, see the Creating and Managing Industrial Graphics 
User’s Guide.  

Editing an Industrial Graphic includes applying an Element Style to the symbol. For more information 
about using Element Styles, see the Application Server User Guide.  

3. Click Close and Save. The changes are saved and the Industrial Graphic Editor closes.  

4. If the ArchestrA object is hosted by an instance or template, save and close the object editor in the 
IDE.  

 

Accepting Symbol Changes in WindowMaker 

If an Industrial Graphic changes and you are currently using it in an InTouch window in Wind owMaker, 
you can immediately accept the change in WindowMaker.  

If you do not accept the change immediately, the symbol is updated in WindowMaker when the window is 

closed and opened again.  

The symbol is also updated if you switch to WindowViewer to test the application or if you open the 
application in WindowViewer on a target node. 

To immediately accept symbol changes in WindowMaker 

 For opened InTouch windows that contain embedded Industrial Graphics, do one of the following:  

o Double-click the Symbol Changed icon in the bottom right corner of the status bar.  

o Close the InTouch window containing the embedded Industrial Graphic and open it again.  

In both cases, the changes made to the Industrial Graphic are reflected in the embedded symbol in 

the InTouch window. 
 

Accepting Symbol Changes in WindowViewer 

If an Industrial Graphic changes and you are currently testing it in WindowViewer, you can accept the 

change in WindowViewer. 

For more information about testing embedded Industrial Graphics, see Testing Industrial Graphics in 
WindowViewer on page 60. 
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To accept symbol changes in WindowViewer when testing 

 Do one of the following: 

o Fast-switch to WindowMaker and then back to WindowViewer.  

o Close the InTouch window and open it again. This only works if the Always load windows from 

disk option is checked in the WindowViewer Properties dialog box.  

In both cases, the changes made to the Industrial Graphic are reflected in the embedded Industrial 
Graphic in the InTouch window.  

 

Testing Industrial Graphics in WindowViewer 
You can test the embedded Industrial Graphic in an InTouch window without having to derive an 
InTouchViewApp instance. You can test an embedded Industrial Graphic if you previously:  

 Created an Industrial Graphic in the Graphic Toolbox, in an automation template or automation 

instance. 

 Created a managed InTouch application.  
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 Embedded the Industrial Graphic in the managed InTouch application.  

 

To test embedded Industrial Graphics in WindowViewer 

1. In WindowMaker, click Runtime to switch to WindowViewer.  

2. Test the animations, behavior, and appearance of the embedded symbol as you would in a normal 
run-time environment.  

3. You can fast-switch back to WindowMaker to make changes to the way the Industrial Graphic is 
embedded.  

To change and test embedded Industrial Graphics in WindowViewer 

1. Make changes to the Industrial Graphic in the Industrial Graphic Editor.  

2. Save the changes.  

If WindowViewer is open, then after a short while, a message appears in WindowViewer prompting 
you to accept the changes. Click Yes.  
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If WindowViewer is closed, then you can fast-switch from WindowMaker to WindowViewer to see 
your changes. It is faster to close WindowViewer and to re-open WindowViewer than to wait for the 
changes to propagate to the open WindowViewer session.  

 

Estimating Graphic Performance 
You can gauge the performance of an Industrial Graphic at run time using the Graphics Performance 
Index (GPI).  

This tool calculates the estimated call up time when the symbol you are building in the Industrial Graphic 
Editor is launched at run time. Call up time pertains to the interval between the user or system requesting 
the pertinent graphic to appear and the graphic appearing on the screen with live data. The calculation is 

based on contents of the symbol launched in the InTouch WindowViewer at run time, and on a best case 
time estimate with completed external reference subscriptions.  

For more information about using GPI, see "Estimating Graphic Performance" in the Industrial Graphic 

Editor User Guide.  
 

Creating New Automation Instances 
You can quickly create a new instance of the AutomationObject that hosts an embedded Industrial 

Graphic. This way, you do not need to switch to the ArchestrA IDE and derive an instance.  

The new instance is unassigned, so you need to assign and deploy it in the ArchestrA IDE before you can 
use it. 

You can only create new Automation instances for Industrial Graphics hosted by templates or instances. 
Industrial Graphics in the Graphic Toolbox do not have this functionality.  

To create a new Automation instance 

1. Right -click the embedded Industrial Graphic, point to Industrial Graphic, and then click New 
Instance. The Create Instance box dialog box appears. 

 

2. In the Instance Name box, type a name for the instance.  

3. Click OK. An instance is automatically derived from the template with the name you specify.  
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About Using Managed InTouch Applications at Run Time 
You can run managed InTouch applications on remote nodes by deploying InTouchViewApp instances 
to those nodes. 

You can also deploy changes of the InTouch application and contained Industrial Graphics to these 

nodes and select whether to accept or decline the changes for each node.  

The following graphic shows how managed InTouch applications are deployed to run-time nodes. 

ArchestrA IDE
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Application
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Application Manager on Node 1
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Deploying a Managed InTouch Application 
You can deploy a managed InTouch application from the ArchestrA IDE to the local node or a remote 

node. After you deploy the application, you can run it in WindowViewer on the remote nodes.  

Note: WindowViewer can run only one application at a time. If a platform is deployed on a local node, the 

configured styles of the Galaxy will take precedence over any configured styles in any other standalone 
or managed applications. 

 

Deploying a InTouchViewApp Object for the First Time 

The first time you deploy an InTouchViewApp object, the associated InTouch application is copied to the 
node of the plat form that hosts the object. This is called the operator node.  

To deploy a managed InTouch application 

1. Open the ArchestrA IDE.  

2. Select the instance of the InTouchViewApp for which you want to deploy the managed InTouch 
application. 

3. On the Object menu, click Deploy. The Deploy dialog box appears.  

4. Click OK. The complete InTouch application is copied to the operator node.  
 

Deploying Changes to a Managed InTouch Application 

You can change a managed InTouch application by:  

 Changing the references, content, or size of an Industrial Graphic that is used in a managed InTouch 
application. 

 Changing the managed InTouch application itself by opening WindowMaker from the 

InTouchViewApp template. 

In both cases, when you save the changes, the changes are propagated from the updated template to 
the derived instances. The changes are identified by the Pending Changes icon.  

The changes are not immediately reflected in a running WindowViewer session. The operator of each 
node can select to accept or decline the changes. For more information, see Accepting New Application 
Versions at the Operator Node on page 65.  

To deploy changes to a managed InTouch application 

1. Open the ArchestrA IDE.  

2. Select the instance of the InTouchViewApp for which you want to deploy the changes of a managed 
InTouch application. 

3. On the Object menu, click Deploy. The Deploy dialog box appears.  

4. Click OK. The changes are copied to the operator node.  
 

Starting a Managed InTouch Application 
From the operator node, you can start Application Manager and select the managed InTouch application 

you want to run.  

You can also set the resolution in Application Manager to run the managed InTouch application in 
different resolutions. 

To start the managed InTouch application 

1. On the node the InTouchViewApp object is deployed to, start the InTouch Application Manager.  
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2. In the application list, select the managed InTouch application you want to run in WindowViewer.  

3. Click the WindowViewer icon. The application starts in WindowViewer after a short while.  

To set the dynamic resolution conversion settings 

1. Open the InTouch Application Manager.  

2. On the Tools menu, click Node Properties. The Node Properties dialog box appears.  

3. Click the Resolution tab.  

4. Select the Allow WindowViewer to dynamically change resolution check box. 

If Allow WindowViewer to dynamically change resolution is unchecked, the managed application 
runs with the resolution in which it was developed.  

5. Configure how you want to run the application. Do any of the following:  

o Click Use application resolution to run the managed application at the same resolution as it 
was developed in.  

o Click Convert to screen video resolution to convert the managed application so that it can run 

with the screen resolution.  

o Click Custom resolution to convert the managed application to a specified resolution.  

6. Click OK. 
 

Controlling the WindowViewer Restart Wait Period When Deploying 

Managed Applications 

You can control the delay that occurs before WindowViewer is restarted when mana ged applications that 
require a restart are deployed. Delays are implemented to ensure the proper operation of the alarm 
subsystem. 

The WindowViewer restart delay is controlled by the following parameters in the win.ini file, which is 
located in the local C:\Windows folder. All parameter values are in seconds.  

 ViewManagedRestartWaitPeriod=0 

This parameter controls the WindowViewer restart wait period. The default is 0, or no wait period.  

 ViewNADShutdownWaitPeriod=30 

For applications managed using Network Application Development (NAD), this parameter controls 

the delay before NAD is shutdown. The default is 30 seconds.  

 ViewNADRestartWaitPeriod=90 

For applications managed using NAD, this parameter controls the delay before NAD is restarted. 

The default is 90 seconds.  
 

Accepting New Application Versions at the Operator Node 
If the managed InTouch application is changed and its associated InTouchViewApp instance is 

deployed, you can select to accept or decline the changes at the run-time node. 

A message appears prompting you if you want to accept the changes to the managed InTouch 
application: 

 When you start WindowViewer from the InTouch Application Manager.  
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 While WindowViewer is running.  

 

Depending on the nature of the change, you may be prompted to restart the WindowViewer application, 
or just reload it. You can also set the behavior of WindowViewer for application changes, such as: 

 How WindowViewer accepts or rejects these changes. 

 How frequently WindowViewer should remind you to reload or restart WindowViewer when changes 
are pending.  

To accept new application versions at the operator node 

 Click Yes. The changes to the managed InTouch application are copied to the operator node and 

WindowViewer restarts or reloads. 

To set the behavior of WindowViewer for application changes 

1. Open the managed InTouch application in WindowMaker.  

2. On the Special menu, point to Configure, and then click WindowViewer. The WindowViewer 
Properties dialog box appears. 
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3. Click the Managed Application tab. 

 

4. In the Change Mode area, configure how WindowViewer responds when changes are deployed. Do 

any of the following:  

o Click Ignore Changes to have WindowViewer ignore any deployed changes. You can manually 
configure the RestartWindowViewer() and ReloadWindowViewer() script functions to accept the 

changes depending on the $ApplicationChanged system tag.  

o Click Restart WindowViewer to have WindowViewer restart automatically.  

o Click Prompt user to restart WindowViewer to have WindowViewer prompt you to restart 

WindowViewer.  

o Click Load changes into WindowViewer to have WindowViewer load the changes 
automatically.  

o Click Prompt user to load changes into WindowViewer to have WindowViewer prompt you to 
load changes into WindowViewer. 
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Note: If you select the Load changes into.. or Prompt user to load.. options, WindowViewer must be 
restarted to recognize changes to a managed application. Even with these options selected, you will be 

prompted to restart WindowViewer. 

5. In the Reminder Interval (sec) box, type how often, in seconds, the user is reminded to load or 

restart the changes into WindowViewer. This option is only available when the applicable change 
mode has been set. Set the interval to 0 to not remind the user again.  

6. Click OK. 

To set the default behavior for WindowViewer 

1. Open the managed InTouch application in WindowMaker.  

2. On the Special menu, point to Configure, and then click WindowViewer. The WindowViewer 
Properties dialog box appears. 

3. Click the Managed Application tab. 

4. Click Restore Defaults. The settings are reset to their default values. 

5. Click OK. 
 

Running ArchestrA Scripts in Embedded Industrial Graphics 
When you run a managed InTouch application in WindowViewer, any ArchestrA scripts associated with 
elements or symbol scripts themselves run as expected. 

However, some scripts contained in symbols can run for a long time and stop you from interacting with 
other InTouch elements. 

To prevent this, you can set a script time-out that is applicable for all scripts in the managed InTouch 

application. A script time out stops script execution and returns the control to the operator.  

By default, scripts time out after 5 seconds. 

To set the script time-out 

1. Open a managed InTouch application in WindowMaker.  

2. On the Special menu, click Configure, and then WindowViewer. The WindowViewer Properties 

dialog box appears. 
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3. Click the Managed Application tab. 

 

4. In the Script timeout (msec) box, type a value in milliseconds. 

5. Click OK. 
 

Deploying the InTouchViewApp Object in a Terminal Services 
Environment 

You can run managed InTouch applications in a Terminal Services environment. The main advantage of 
this architecture is that you can run multiple InTouch applications on one computer at the same time. 

To do this, you must: 

 Use InTouch Terminal Services Edition. 

 Deploy each InTouchViewApp instance with its own ViewEngine host, if you have several 
InTouchViewApplication instances on the terminal server node.  
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 Run each managed InTouch application in its own terminal services client session.  

Galaxy and Development Node

WindowMaker

Terminal Server

ArchestrA
IDE

InTouch 
(Terminal 
Services)

Client1 Client2

ArchestrA 
Platform

WindowViewer running 
InTouchViewApp1

WindowViewer running 
InTouchViewApp2

Deploy Deploy

Edit

InTouchViewApp1

$InTouchViewApp1
$InTouchViewApp2

InTouchViewApp2

VisualizationVisualization

Derive

Managed InTouch Applications
in a Terminal Services Environment

 

Note: Only one InTouchViewApp object needs to be deployed on the terminal server node to make the 

application available to multiple terminal session clients. There is no need to deploy a separate 
InTouchViewApp object on the terminal server node for each client that will use the application.  
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